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Introduction 
 

This guide walks Enterprise Account Managers through the complete on-boarding process in 
HubSpot — from the moment Sales submits an Intake Ticket to the final campaign launch. The 
Enterprise on-boarding workflow is managed across two interconnected record types: the Intake 
Ticket and the On-Boarding Project. 
 
Understanding how these two records relate to each other is the key to managing your accounts 
efficiently. As an AM, your role spans both systems throughout the entire on-boarding lifecycle. 
 

How the Two Records Work Together 

The Intake Ticket tracks everything from the initial sales handoff through the end of the 
post-intake period. It is where you manage pre-call preparation, conduct the intake call, and 
complete post-intake actions before build can begin. 

 

The On-Boarding Project is the build record that gets activated once the Intake Ticket moves to 
"Begin Build." This is where the Specialist works through campaign construction and where you 
track build milestones, review campaigns, and execute launches. 

 

These two records are linked to the same Service record, which ties them to the Company and is 
where launch status is ultimately recorded. 

 

Part 1: Managing the Enterprise Intake Ticket 
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The Intake Ticket is created by Sales and moves through a series of automated stages. Each 
stage transition generates new tasks for the AM. Your job is to complete those tasks and, at key 
moments, manually advance the ticket status to trigger the next phase. 
 

1.1  The Intake Ticket Lifecycle at a Glance 
 

Stage What Happens AM Action Required 

Intake Scheduled Sales submits ticket with date, time block, 
product mix, and client email. 

None — awaiting assignment. 

Awaiting AM 
Assignment 

Leadership assigns ENT division; Team 
Lead is assigned. Team Lead gets a task 
to assign to the AM. 

None — wait to be assigned. 

AM Assigned Team Lead updates assignee to you and 
marks task complete. You are notified by 
email and task notification. 

Send Welcome Email, confirm 
Zoom meeting, check in with 
Specialist. 

Pre-Intake 
Preparation 

Triggered when you complete the 
Welcome Email task. New prep tasks are 
generated. 

Complete all pre-intake prep tasks 
(3 business day window). 

Intake Call Automatically triggered 1 day before the 
intake date. 

Complete the Intake Call playbook, 
link GMC/Meta Business if 
applicable, move ticket status 
when complete. 

Intake Call 
Completed 

Triggered manually by you after the call is 
finished. 

Complete all post-intake tasks. 

Begin Build Triggered manually by you once all 
post-intake work is done. Activates the 
On-Boarding Project. 

Mark final task complete to hand 
off to Specialist. 

 

1.2  Getting Assigned to an Intake 
You will receive two notifications when a new Intake Ticket is assigned to you: 
 

•​ A HubSpot task notification for the tasks generated at the AM Assigned stage. 
•​ An email notification from HubSpot confirming your assignment to the ticket. 

 
When you open the ticket, you will see three tasks waiting in the Activity feed under Upcoming: 
 

# Task Notes 

1 Send Welcome Email to Client Complete immediately. Triggers 
Pre-Intake Preparation stage. 
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2 Ensure Zoom Meeting Details Are Shared With 
Client & Confirm Contact Method 

Complete alongside or immediately 
after the welcome email. 

3 Check-In With Specialist 1 business day lead time — connect 
with the PSS before the intake call. 

 

Important: Email Template 

Use the HubSpot Welcome Email template when sending your initial outreach. The template 
includes an intake questionnaire link for the client to pre-fill before the call. 

 

To access: Open the Email action on the Ticket record and type "welcome" in the template 
search bar. The template will auto-populate contact and company fields. 

 

You can also use the HubSpot Outlook plugin to access templates from your inbox. 
 
After sending the Welcome Email, mark that task complete. This is the action that moves the 
ticket forward to Pre-Intake Preparation and generates your next set of tasks. 
 

1.3  Pre-Intake Preparation 
Once you mark the Welcome Email task complete, the ticket advances to Pre-Intake 
Preparation and generates several new tasks. These tasks have a 3 business day completion 
window and do not necessarily align with the exact date of the intake call — they are meant to 
ensure you are fully prepared before you get on that call. 
 

# Task Notes 

1 
Review Sales Activity Feed Go to the Company record and 

review all Sales communications, 
notes, and recorded calls. 

2 

Pre-Fill Intake Playbook Using HubSpot 
Assistance 

Open the Intake Playbook from the 
Playbooks card on the Ticket record 
and fill it out as thoroughly as 
possible using sales notes and 
questionnaire responses. 

3 
Update Quickbase Account Numbers Log any CIDs or other Quickbase 

account identifiers that have been 
made available. 

4 
Review Client Website & Audit Attribution Points Audit the client website for forms, 

phone numbers, tracking pixels, and 
other attribution points. 

5 Review Returned Client Questionnaire, If Possible Check for a form submission from the 
client via the Activity Feed (filter for 
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Form Activity) or via Marketing > 
Forms > search "Intake". 

6 
Review Google Ads Platform Performance, If 
Possible 

Review historical performance data 
from the platform if accessible prior to 
the intake. 

 

Reviewing the Client Questionnaire 
Clients receive an intake questionnaire link in the welcome email. If they fill it out, their 
responses can be found in two ways: 
 
Option 1 — Via the Activity Feed: 

1.​ On the Ticket record, go to the Activities tab. 
2.​ Click Filter Activity. 
3.​ Check Form Activity and apply the filter. 
4.​ If the client submitted the form, a form submission card will appear in the feed. 

 
Option 2 — Via Marketing > Forms: 

5.​ Navigate to Marketing in the left sidebar. 
6.​ Select Forms from the dropdown. 
7.​ Search for "Intake" in the search bar. 
8.​ Select the form matching the client's product mix (e.g., Paid Search Intake 

Questionnaire, Paid Social Intake Questionnaire). 
9.​ Find the client's contact in the submissions list and click to view their responses. 

 

Pre-Filling the Intake Playbook 
The Intake Playbook is a structured record for capturing client information that the Specialist will 
use during the build. Filling it out before the call — and updating it during the call — ensures 
nothing is lost. 
 

10.​On the Ticket record, scroll to the Playbooks card in the right column. 
11.​Search for the playbook matching the client's product mix (e.g., "Intake Record – 

PPC/PS Ecomm"). 
12.​The playbook opens in a pop-up window. 
13.​Fill out as many fields as possible using the sales activity feed, questionnaire responses, 

and your own research. 
14.​The playbook auto-saves as you fill it out — no need to manually save. 
15.​Once complete, return to the Ticket record and mark the Pre-Fill Intake Playbook task as 

complete. 
 

Tip: Using HubSpot AI to Pre-Fill 

Confidential | Internal Use OnlyPage 4 



Enterprise On-Boarding: Account Manager User GuideLogical Position | HubSpot Migration 

Task descriptions on the Ticket record include a tip about using HubSpot's AI Assistant to speed 
up playbook pre-filling. You can copy sections of the Intake Questionnaire into the Assistant to 
generate suggested responses. Results will vary based on note quality. 

 

1.4  Intake Call 
When the Intake Date on the ticket reaches 1 day out, HubSpot automatically moves the ticket 
status to Intake Call. This generates three tasks for you to complete on or immediately after the 
call: 
 

# Task Notes 

1 
Fill Out Remaining Intake Playbook Questions 
During Intake Call 

Complete any fields not pre-filled. 
Use the call to gather information 
directly from the client. 

2 Link Client GMC to LP Merchant Center Account Required for Ecommerce clients only. 

3 Link Meta Business to LP Account Required for Paid Social clients only. 
 
The final intake call task is to move the ticket status forward. This is done as a task action, not a 
manual status change: 
 

•​ Move Ticket Status to "Intake Completed" Once Intake Call Is Finished — mark this task 
complete when the call ends. 

 

Note: Using Zoom for Your Intake Call 

We strongly recommend scheduling the intake call through HubSpot's Zoom meeting scheduler 
so the call is automatically logged, transcribed, and summarized via ZRA. If you use a different 
scheduler, you will not receive automatic transcription — which you are likely accustomed to if 
you have been using Zoom regularly. 

 

You can schedule the meeting directly from the Ticket record using the Meeting action at the top 
of the Activity panel. 

 

1.5  Post-Intake Tasks 
After you manually move the ticket status to Intake Call Completed, a new set of post-intake 
tasks is generated. These are familiar actions that mirror what you have historically done in 
Quickbase after an intake. 
 

# Task Notes 
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1 Create Search Operation in Quickbase Create the Quickbase record for the 
new account. 

2 Update Intake Notes in Quickbase & Mark Intake 
As Complete 

Finalize the intake notes in 
Quickbase. 

3 Schedule Post-Intake Meeting with Specialist Set up time to debrief with your PSS 
and hand off build details. 

4 Schedule Staged Launch Calls With Client & Send 
Summary Email 

Confirm launch call dates and send 
the client a post-intake summary. 

5 
Submit Support Requests, If Necessary Submit any Code Install, Data Feed, 

or other support requests needed 
before the build can begin. 

 
As you complete each post-intake task, mark it complete on the Ticket record. Once all 
post-intake work is done, you will see the final task: 
 

•​ Move Ticket Status to "Begin Build" Once Post-Intake Call Work Is Finished — 
completing this task is what activates the On-Boarding Project and hands the build off to 
the Specialist. 

 

What Happens When You Move to Begin Build 

Manually moving the Ticket Status to "Begin Build" triggers the corresponding On-Boarding 
Project to advance from its holding stage into Build In Progress. The Specialist receives their first 
set of build tasks and work begins. From this point forward, the On-Boarding Project becomes 
your primary tracking record. 

 

​
 

Part 2: Managing the On-Boarding Project 
 

Once the Ticket moves to Begin Build, the On-Boarding Project is in Build In Progress. This is 
where you will track the Specialist's progress, complete your own build-period tasks, review 
campaigns pre-launch, and mark each campaign set as launched. For Enterprise clients, the 
build is structured as a staged process with multiple campaign sets. 
 

2.1  On-Boarding Project Stages at a Glance 
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Stage What Happens AM Action Required 

Build In Progress Specialist begins constructing campaigns. 
Staged Build Status field shows which 
Build Stage they are in (Stage 1, 2, or 3). 

Complete AM build-period tasks 
(product mix dependent). 

Build Review Specialist submits their campaign set for 
Team Lead review using the Build Review 
Status field. 

None — await Team Lead 
approval. 

Build Completed Team Lead sets Build Review Status to 
Approved. You receive an email 
notification. 

Review the build and submit any 
changes to the Specialist. 

Launch AM reviews campaigns, coordinates any 
revisions, and marks campaigns as 
launched via the Service record. 

Complete the two launch tasks: 
Review Build & Mark Campaigns 
As Launched. 

Back to Build In 
Progress 

Specialist begins the next campaign set. 
Cycle repeats for each staged build. 

Repeat review and launch process 
for each campaign set. 

On-Boarding 
Completed 

All campaign sets are launched and the 
final Staged Launch property is updated 
on the Service. 

Confirm Optimization Project has 
been generated. 

 

2.2  Your Tasks During the Build Period 
When the On-Boarding Project enters Build In Progress and the Staged Build Status moves to 
Build Stage 1, HubSpot generates a set of tasks for you as the AM. The number and type of 
tasks vary based on product mix, but may include: 
 

•​ Task: Send Data Feed Audit to Client 
•​ Task: Ensure Outstanding PPC Action Items For Launch Are Complete 
•​ Other product-specific tasks depending on the services being built 

 
Complete these tasks as they apply and mark them complete on the On-Boarding Project 
record. 
 

2.3  Build Review & Email Notification 
When the Specialist finishes a campaign set, they submit it for review by updating the Build 
Review Status field to "Build Submitted For Review." The Project Stage moves to Build Review. 
The Team Lead then reviews the build and, if approved, sets the Build Review Status to "No 
Further Changes Or Suggestions (Approved)." This moves the Project Stage to Build 
Completed. 
 
When the Project reaches Build Completed, you will receive an automated email notification 
from HubSpot that reads: 
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Paid Media Build Completed​
A Paid Media Build for [Client Name] has been Completed. Please review the 
Campaigns and schedule the Launch Call with the Client. 

 
This email is your trigger to action. Open the On-Boarding Project and complete your two 
post-build launch tasks. 
 

2.4  Reviewing the Build & Launching Campaigns 
After the build is approved and you receive the email notification, two tasks are generated for 
you on the On-Boarding Project: 
 

# Task Notes 

1 
Review PPC Build & Submit Necessary Changes Review the campaign set the 

Specialist built. Coordinate with them 
on any revisions needed before 
launch. 

2 
Mark Campaigns As Launched After the launch call with the client is 

complete, mark this task to initiate the 
launch steps on the Service record. 

 

Step-by-Step: Marking the Launch as Complete 
After completing your scheduled launch call with the client, follow these steps to officially record 
the launch: 
 

16.​On the On-Boarding Project record, locate the Mark Campaigns As Launched task and 
open it. 

17.​Navigate to the associated Service record. You can find it in the Services section of the 
Project's right-column sidebar. 

18.​On the Service record, locate the Enterprise Launch section in the left column. 
19.​Click the Enterprise Staged Launch dropdown and select the appropriate launch stage 

(Staged Launch 1 for the first campaign set, Staged Launch 2 for the second, and so 
on). 

20.​Save the change. 
 

What This Action Triggers 

Updating the Enterprise Staged Launch property from null to Staged Launch 1 (or 2, or 3) tells 
HubSpot to automatically generate a new Optimization Project for the Specialist. This is the 
equivalent of marking Week 0 complete in Quickbase. The Optimization Project is where the 
Specialist will perform all ongoing weekly optimizations for that campaign set going forward. 
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2.5  Repeating the Cycle for Each Campaign Set 
Enterprise builds are staged — meaning the Specialist builds one campaign set at a time, each 
going through its own Build Review and Launch cycle. Once you update the Staged Launch 
property for the first campaign set, the On-Boarding Project automatically moves back to Build 
In Progress as the Specialist begins the next set. 
 
You will continue to receive email notifications each time a campaign set is completed and 
reviewed. For each subsequent launch, the same two tasks will be generated: Review Build and 
Mark Campaigns As Launched. The process repeats until all campaign sets are built and 
launched. 
 
The Staged Build Status field on the Project tracks where the Specialist is in the build process. 
The possible values are: 
 

•​ Build Stage 1 — First campaign set under construction 
•​ Build Stage 2 — Second campaign set under construction 
•​ Build Stage 3 — Third campaign set under construction 
•​ Staged Build Completed — All campaign sets have been built 

 

​
 

Part 3: Navigation & Quick Reference 
 

3.1  Finding Your Intake Tickets 
To find your active Intake Tickets: 
 

21.​In HubSpot, navigate to Service in the left sidebar. 
22.​Select Tickets from the dropdown. 
23.​Use the Index View filters to filter by Assignee = You and Pipeline = Paid Media Intake 

Ticket. 
24.​Your active tickets will display with their current pipeline stage visible. 

 

3.2  Finding Your On-Boarding Projects 
To find active On-Boarding Projects assigned to your accounts: 
 

25.​Navigate to CRM > Projects in the left sidebar. 
26.​Filter the view by Pipeline = Paid Media Operations - On-Boarding. 
27.​Filter by Assigned To = You or use your team's designated Index View. 
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You can also navigate to an On-Boarding Project directly from the Intake Ticket or the Service 
record by clicking on the associated Project in the Projects section of the right-column sidebar. 
 

3.3  Navigating Between Records 
All three key record types — the Intake Ticket, the On-Boarding Project, and the Service — are 
linked to each other through HubSpot associations. The Service record is the central hub: 
 

•​ From the Ticket: The associated Service is shown in the Services panel on the right 
column. 

•​ From the Project: The associated Service is shown in the Services panel on the right 
column. 

•​ From the Service: Both the Intake Ticket and the On-Boarding Project appear in the 
Projects panel, and the Company appears in the Companies panel. 

 

3.4  Key Automations to Know 
HubSpot handles a significant amount of stage progression and task generation automatically. 
The table below summarizes the most important automation triggers and what they produce: 
 

Trigger (Who Does It) Stage Change What Is Generated 

Complete "Send Welcome Email" task 
(AM) 

AM Assigned → Pre-Intake 
Preparation 

Pre-intake prep tasks for AM 

1 day before Intake Date (Automatic) Pre-Intake Preparation → 
Intake Call 

Intake call tasks for AM 

Complete "Move Ticket to Intake 
Completed" task (AM) 

Intake Call → Intake Call 
Completed 

Post-intake tasks for AM 

Complete "Move Ticket to Begin Build" 
task (AM) 

Intake Call Completed → 
Begin Build → activates 
On-Boarding Project 

Activates the On-Boarding 
Project; Specialist gets build 
tasks 

PSS marks "Meet With AM" task 
complete (PSS) 

On-Boarding Project → Build 
In Progress 

AM build-period tasks; Staged 
Build Status set to Build Stage 1 

PSS updates Build Review Status to 
"Build Submitted for Review" (PSS) 

On-Boarding Project → Build 
Review 

None — Team Lead reviews 

Team Lead sets Build Review Status 
to Approved (Team Lead) 

Build Review → Build 
Completed 

AM email notification; AM gets 
two launch tasks 

AM updates Enterprise Staged 
Launch on the Service (AM) 

Build Completed → Back to 
Build In Progress (for next set) 

Optimization Project generated; 
cycle repeats 

 

​
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Part 4: Common Questions & Troubleshooting 
 

 

My ticket was not automatically associated with the right Service or Company. What do I 
do? 
HubSpot automations handle these associations, but they can occasionally fail. If the Service or 
Company is missing from your Intake Ticket's right-column sidebar, contact your Team Lead. If 
the issue cannot be resolved quickly, you can also reach out to Tristan Storr directly for 
assistance. 
 

My tasks have not generated after I completed the previous stage's task. What do I do? 
Give HubSpot a few seconds and refresh the page — automations sometimes have a short 
delay. If tasks still have not appeared after refreshing, reach out to your Team Lead or to support 
in the HubSpot Teams channel. 
 

The Specialist is not in HubSpot yet. Where is the On-Boarding Project? 
The On-Boarding Project is not activated until the Intake Ticket reaches Begin Build. If the 
Specialist has not started receiving tasks, confirm that you have completed the final post-intake 
task to move the ticket to Begin Build. 
 

I cannot find the right Intake Questionnaire form. Which one do I use? 
Select the form that matches the client's product mix: use the Paid Search Intake Questionnaire 
for PPC clients, the Paid Social Intake Questionnaire for Social clients, and the Paid Search & 
Paid Social Intake Questionnaire for multi-product clients. If you are uncertain, check the Paid 
Media Intake Products field on the ticket. 
 

The client did not fill out the questionnaire. What should I do? 
That is okay — use the available sales activity, recorded calls, and notes on the Company 
record to pre-fill the Intake Playbook as thoroughly as possible. Complete the review task and 
note in the playbook that the client did not return the questionnaire. 
 

I launched the first campaign set. When does the Optimization Project appear? 
The Optimization Project is generated automatically when you update the Enterprise Staged 
Launch property on the Service record from null to Staged Launch 1 (or the next applicable 
stage). If the project does not appear within a few minutes of saving that change, contact your 
Team Lead. 
 

Additional Resources 
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The following resources are linked in the auto-generated resource note pinned to every Intake 
Ticket: 
 

•​ Legacy PMOS Resources — Reference documents for legacy Quickbase processes 
•​ Paid Media Intakes Workflow Guide — Overview of the intake workflow 
•​ Managing Intakes - What's Next? — Post-intake actions and handoff guidance 
•​ Paid Media Intake Demo Slides — Training slides and process overview 

 
For support during the transition, contact your Team Lead or reach out in the dedicated HubSpot 
Support channel in Microsoft Teams. 

 
This document is for internal use only. For questions or updates, contact Tristan Storr. 

Confidential | Internal Use OnlyPage 12 


	Introduction 
	Part 1: Managing the Enterprise Intake Ticket 
	1.1  The Intake Ticket Lifecycle at a Glance 
	1.2  Getting Assigned to an Intake 
	1.3  Pre-Intake Preparation 
	Reviewing the Client Questionnaire 
	Pre-Filling the Intake Playbook 

	1.4  Intake Call 
	1.5  Post-Intake Tasks 

	Part 2: Managing the On-Boarding Project 
	2.1  On-Boarding Project Stages at a Glance 
	2.2  Your Tasks During the Build Period 
	2.3  Build Review & Email Notification 
	2.4  Reviewing the Build & Launching Campaigns 
	Step-by-Step: Marking the Launch as Complete 

	2.5  Repeating the Cycle for Each Campaign Set 

	Part 3: Navigation & Quick Reference 
	3.1  Finding Your Intake Tickets 
	3.2  Finding Your On-Boarding Projects 
	3.3  Navigating Between Records 
	3.4  Key Automations to Know 

	Part 4: Common Questions & Troubleshooting 
	My ticket was not automatically associated with the right Service or Company. What do I do? 
	My tasks have not generated after I completed the previous stage's task. What do I do? 
	The Specialist is not in HubSpot yet. Where is the On-Boarding Project? 
	I cannot find the right Intake Questionnaire form. Which one do I use? 
	The client did not fill out the questionnaire. What should I do? 
	I launched the first campaign set. When does the Optimization Project appear? 

	Additional Resources 

